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1. Introduction 

1.1 Safety Instructions (Supplemental Directives) 

1.1.1 General Safety Instructions 
Where the instructions below use the term device, this refers to the skeye.pad POS, 
the associated desktop cradle, the battery charger station, the battery and other 
electrical accessories supplied by skeye or Höft & Wessel.  
 

 
 
♦ Use only the HW 50396 desktop cradle or the HW 16396 battery charger to 

charge the battery. There is a risk of explosion and fire if other chargers are 
used. 
 

♦ Never expose your device to extreme temperatures, for example, by leaving it 
under the windshield in a vehicle. There is a risk of explosion and fire. 
 

♦ Switch off the device immediately if it starts to emit smoke, unusual odors or 
noises. If you continue to use the device, there is a risk of fire and electric 
shock. Have the device repaired by the bring-in service. 
 

♦ Please note that the paper cutter on the skeye.pad POS is sharp and can cause cuts 
if handled carelessly. 
 

♦ Do not place any objects on the device! It could fall and injure someone. 
 

 
 
♦ Only operate your skeye.pad POS with the accessories supplied, the use of other 

accessories will lead to defects. 
 

♦ Do not use your device in humid environments (bathrooms, swimming pools etc.). It 
must be protected against splashes of water and other fluids. Liquids can penetrate 
the device through the openings on the casing and cause a short circuit. 
 

♦ Do not insert any objects that do not meet the specified purpose into the openings on 
the casing. This will cause damage to the casing and could lead to a short circuit. 
 

♦ Protect your skeye.pad POS from dust. Dust could penetrate your skeye.pad POS 
and interfere with its proper functioning.  
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♦ Only store the skeye.pad POS with a fully charged battery fitted. Otherwise the 
power reserves in the floating battery will be consumed. Discharged floating batteries 
must be replaced by qualified service personnel. 
 

♦ The skeye.pad POS is not a toy. Store your skeye.pad POS out of reach of young 
children. 
 

♦ Protect the skeye.pad POS against theft and misuse! 
The skeye.pad POS contains data that can represent large [monetary] values! 
 

♦ The device does not contain any parts that can be maintained, replaced or repaired 
by customers or service personnel not employed by Höft & Wessel! If you open the 
device improperly, this leads to the destruction of the casing and to the loss of data 
in the skeye.pad POS! 

 

1.1.2 Safety Instructions for the Battery 
A lithium-ion battery is fitted at the rear of the skeye.pad POS.  The lithium-ion battery is 
characterized by a high energy density. It is thermally stable, delivers a constant 
voltage throughout the discharge period and is not subject to a memory effect. 
 

 
 
♦ The battery is sensitive to mechanical and thermal shocks. Furthermore, the 

chemicals contained in the battery are highly reactive. The battery should 
therefore only be used for the purpose intended and should be handled with 
care. Otherwise, you run the risk of causing an explosion or fire, which could 
result in serious personal injury! 

 
Mechanical shock 
♦ The battery must not be:  

• thrown!  
• dismantled!  
• modified! 
• punctured with a nail or other sharp objects!  
• subjected to impact by a heavy object, for example, trodden on or hit with a 

hammer!  
Mechanical damage can lead to internal short circuits. The high current can melt 
the casing and cause it to catch fire. Under certain circumstances, this defect may 
not be immediately apparent. The battery can still explode or burst into flames 30 
minutes after the damage is inflicted.  
 
Chemical Reactions  
♦ Do not immerse the battery in water or salt water or allow it to get wet! 

Lithium is a highly reactive metal. The components of a lithium-ion battery are 
highly combustible. Although lithium-ion batteries are hermetically sealed, 
they should not be immersed in water; (defective) lithium cells react violently 
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with water, particularly when fully charged. Burning batteries must therefore 
be extinguished using sand, not water. Otherwise, there is a risk of explosion! 

 
 
Thermal Shock  
♦ The battery must not be: 

• used or charged close to sources of heat such as heaters or open fires! 
• connected to cigarette lighters and other chargers! 
• thrown into a fire or heated! 
• recharged close to open fires or in extremely hot weather! 
• soldered! 
• placed in a microwave or in pressurized containers! 

Exposing the lithium-ion batteries to thermal shock can cause the internal 
barrier between the fluids (separator) to melt, which will lead to a short circuit. 
This poses a risk of explosion and fire! 
 
 
Explosion  
♦ The battery must not be:  

• transported or stored together with metallic objects such as hairpins, 
necklaces or tools! These objects could create a connection between the 
positive and negative terminals of the battery. The resulting short circuit 
creates a risk of fire or explosion! 

• stored with other chargers! Use only the HW 50396 desktop cradle or the 
HW 16396 battery charger to charge the battery. If you use a different 
battery charger, the battery may be overcharged thus creating a risk of fire 
and explosion! 

Internal protection circuits prevent total discharge, overcharging or overloading 
of the battery. If the internal protection circuit is defective or is short-circuited, the 
battery may catch fire or even explode.  
 
 

 
 
If electrolytic fluid leaking from the battery gets into your eyes, do not rub them. 
Instead, rinse them out under running water and then seek immediate medical 
assistance. 
The electrolyte can be rinsed out with water, it does not react like lithium. 
 
If electrolytic fluid leaking from the battery gets onto your clothing or your skin, 
you must wash your skin or clothing under running water to prevent 
contamination of the skin. 
The electrolyte can be rinsed out with water, it does not react like lithium. 
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1.1.3 Safety Instructions for the Power Supply 
The power supply can be used to power the desktop cradle or the battery charger. 
     

 
 
♦ Never plug in or remove the power cable with wet hands. This could give you a 

severe electrical shock. 
 

♦ Handle the power cable with care. For example, do not place any objects on 
the cable, do not subject the cable to excessive bending, twisting or tensile 
forces. 
The use of damaged cables can lead to a fire or an electrical shock. 
 

♦ Do not run the cable close to heaters! The cable's insulation may be damaged 
and this can cause a fire or a severe electrical shock. 
 

♦ Hold the cable by the plug when removing it from an electrical outlet. Do not 
pull the cable itself! The cable's insulation may be damaged and this can cause 
a severe electrical shock. 
 

♦ Never attempt to modify or repair the power cable. Improperly executed repairs 
to the cable could cause a severe electrical shock or lead to fire as a result of a 
short circuit. 
 

♦ Always connect the device directly to a wall outlet; do not use plug strips. 
Overloading a plug strip can cause a fire, resulting in serious personal injury. 
 

♦ The supply voltage must match the technical data displayed on the device, an 
overload or underload could cause a fire. 
 

♦ Disconnect the power plug from the wall on a regular basis and clean the base 
of the contacts and the area between the contacts. If the power plug is left 
plugged in for long periods, dust can accumulated at the base of the contacts, 
which could lead to a short circuit and fire. 
 

♦ Only connect the cable in the manner described in this manual. Other cable 
connections could lead to a short circuit and cause a fire. 
 

♦ Make sure that plug is clean and dry before you plug it in. 
 

♦ Always connect the power cable to the device before connecting it to a wall outlet. 
 

♦ Push the poles of the plug all the way into the wall outlet. 
 

♦ For safety reasons, remove the power plug from the wall outlet if you will not be 
using the device for a long period. 
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Warranty instructions 
 
♦ Only use genuine accessories with your skeye.pad POS. Failure to comply with this 

regulation will invalidate the warranty. 
 

♦ Never attempt to open your skeye.pad POS and/or carry out repairs and/or 
modifications yourself. The manufacturer accepts no liability for any damage that 
may be incurred as a result. 
 

♦ Any interference by unauthorized persons will invalidate the warranty. 
 

♦ Only chargers recommended by the manufacturer may be used to charge the 
battery.  
The use of a different charger could pose a hazard; this will also invalidate the 
warranty for your skeye.pad POS. 
 

♦ Damage caused by improper packaging of the skeye.pad POS during shipping 
and/or unauthorized interference will invalidate the warranty. 
 

 

1.1.4 Safety Notes: WLAN 
Wireless LAN data communication can be easily intercepted and recorded. Anyone 
who is operating a WLAN card in the same subnet can “sniff out” and decrypt any 
sent data packets with the appropriate software.  
 
In order to make unauthorised access to your WLAN more difficult, WLAN functions 
such as Wired Equivalent Privacy (WEP) or WiFI Protected Access (WPA) should 
be enabled.  
Using a VPN allows encryption of the transmitted data and authentication of the 
user on the other end. 
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1.1.4.1 How to Secure your Wireless Network 
We have compiled some tips below to make unauthorised access to your WLAN 
more difficult. 
 
a. Change the password of the router or access point (very important).  

These units are factory-set to a default password. If you do not change this 
password anybody can re-configure your router or access point.  
 

b. Change the address range. Unless you have enabled DHCP (automatic IP 
address allocation), changing the used address range provides additional 
security as the default range no longer works.  
 

c. Give your network a SSID name. This is the network name of your wireless 
network. Change the pre-set name and enter another name.  
 

d. Disable SSID broadcast. The router’s default setting enables broadcasting the 
network name as this simplifies configuration (for instance in Window XP). 
Unfortunately, this also makes your network visible in all WLAN-enabled devices. By hiding your 
SSID, your network name is no longer sent out. 
 

e. Enable MAC filtering. Many access points support access control by filtering 
MAC addresses. Enable this access control and enter the MAC addresses of allowed 
network devices. Now the access point will only allow connections to your PC. Connection will 
be denied to any other devices.  
 

f. Enable WEP Encryption. Access points and Wireless LAN adapter labelled 
with the WiFi logo can encrypt the transmitted data. Please note that WEP 
encryption is not secure. Programs widely available on the Internet can capture 
your data traffic and use this data to obtain the WEP key in a little while. 
 

g. Disable File and Printer Sharing on your Windows PC. (This applies only if 
you are not running a server and do not need to access other PCs over the 
network). This stops unauthorised access to view or modify files on your PC.  
 

h. Disable the Guest Account on your Windows PC.  
 

i. Install a recommended antivirus program.  
 

j. Install a personal firewall.  
 
 
 

 

Please note that despite all these tips, the WLAN is not fully secure; however, 
intruders will have a much harder job breaking into your network.  
If you wish to operate your WLAN to a higher safety standard, please contact 
an IT security consultant (such as a system house). 
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1.1.5 Safety Instructions for Data Loss 

 
 
♦ Back up all data recorded on a regular basis and save these on external storage 

media!  
Under specific circumstances, virtually all electronic storage systems can be affected 
by data loss or data corruption. We therefore accept no liability whatsoever for data 
that is lost or rendered otherwise unusable as a result of improper use, repairs, 
malfunctions, battery problems, software errors or  
any other reasons. 
 
We accept neither direct nor indirect liability for financial losses or claims for 
damages by third parties that could arise from the use of this product and all of its 
associated functions, such as stolen credit card numbers, lost or corrupt data etc. 

 
 

1.1.6 FCC Note 
 

 

 

NOTE: 
This device complies with Part 15 of the FCC Rules. Operation is subject to the 
following two conditions:  
(1) this device may not cause harmful interference, and  
(2) this device must accept any interference received, including interference that 
may cause undesired operation. 
This equipment generates, uses and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause harmful 
interference to radio communications. If this equipment does cause harmful 
interference to radio or television reception, which can be determined by turning 
the equipment off and on, the user is encouraged to try to correct the interference 
by one or more of the following measures: 

• Reorient or relocate the receiving antenna. 
• Increase the separation between the equipment and receiver. 
• Connect the equipment into an outlet on a circuit different from that to which 

the receiver is connected. 
• Consult the dealer or an experienced radio/TV technician for help. 
 
 
 

 

IMPORTANT! 

This device must not be changed or modified unless expressly approved by Höft & Wessel AG. Any 
unapproved modification could void the user´s authority to operate the equipment. 

SAR compliance for the specific transmitter condition was evaluated for body-worn configuration. The 
maximum reported body 1g average SAR value in the 2.4 GHz-band for this filing is: 0.182 mW/g. 

This device must not be co-located or operating in conjunction with any other antenna or transmitter for 
satisfying RF exposure compliance. 
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1.2 Normal Use 

 
The skeye.pad POS is designed for use in commercial environments and is used 
exclusively for data acquisition and transmission purposes (e.g. for selling goods) 
inside buildings or vehicles or  
in outside areas under moderate climatic conditions. 
 
The skeye.pad POS is not intended for use in private households. 
 
Pay attention to all information in this user manual, especially the safety 
instructions. Normal use refers exclusively to the operation of the device in 
accordance with the instructions contained in this documentation. Any other use 
shall not be considered normal use and can lead to property damage or even 
personal injury. 
 
No liability is accepted for any damages incurred as a result of improper use. 
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1.3 Explanations for the Instruction Manual 

1.3.1 Safety Instructions and Pictographs 
Safety instructions always appear in the same format in the instruction manual. This 
manual contains four different levels of safety instructions. 
 
 

 
 

DANGER indicates a hazardous situation which, 
if not avoided, will result in death or serious 
injury. 

 
 

WARNING indicates a hazardous situation which, 
if not avoided, could result in death or serious 
injury. 

 
 

CAUTION used with the safety alert symbol, 
indicates a hazardous situation which, if not 
avoided, could result in minor or moderate injury. 
 
 
 

 
 

NOTICE is used to address practices not related 
to personal injury. 

 
As used in this instruction manual in general and with regard to safety information, 
safety messages and warnings in particular, the following words have the following 
meanings: 
 
May This word is understood to be permissive. You can do what is 

mentioned. 
 

Shall This word is understood to be mandatory. You must do what is 
required. 
 

Should This word is understood to be advisory. It would be a good idea to do 
what is described and it is recommended that you comply. 
 

 
 
 

 

 
This symbol indicates an alternative method of performing a particular task or 
provides additional information about a topic. 
 

 



INTRODUCTION 
 

 
 

1.10 • 18.02.2011 15 

1.3.2 Contents of the Instruction Manual 
The instruction manual has been structured in such a way as to o allow you start 
using your skeye.pad POS quickly. 
The instruction manual is organized into the following sections: 
 
♦ Introduction 
♦ Safety Instructions 
♦ Technical Data 
♦ User Instructions 
♦ Communication Link 
 

1.4 Purpose of the Document 

This user manual provides comprehensive user instructions. 
 

1.5 Target Audience 

This documentation is aimed at all users of the skeye.pad POS. 
 

1.6 Terminology 

skeye.pad POS 
HW 90396 
 

Versatile mobile terminal suitable for a wide range of 
applications. Referred to below as the "skeye.pad POS". 
 

Power supply 
HW 14396 
 

Wide-range power supply for powering the skeye.pad 
POS and the desktop cradle. 
 

Desktop cradle 
HW 50396 
 

Desktop cradle for the skeye.pad POS. 
Allows you connect your skeye.pad POS to a desktop PC. 
 

Battery charger 
HW 16396 
 

External charger for battery model HW 19396. 
 

Compact flash memory 
card 

Compact flash memory card (also referred to below as 
"CF memory card) fitted as an additional data memory for 
the skeye.pad POS. 
 

CF card slot CF card slot. 
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1.7 Product Description 

Operating system: Microsoft Windows CE 5.0 
 

Interfaces: The interfaces provided on the skeye.pad POS allow the use 
of a wide range of accessories and options 
 

Communication: The device can communicate with other systems in different 
ways: 
• Infrared: IrDA 1.0 (SIR=115200 baud) 
• USB 
• Ethernet 
 

Power supply: The skeye.pad POS is powered by rechargeable lithium-ion 
batteries (battery). The battery is recharged by placing the 
skeye.pad POS onto the desktop cradle or by inserting the 
individual batteries into the battery charger. 
 

Environmental 
conditions: 
 

• Operating temperature: +23 °F to +104 °F  (-5°C to +40°C) 
• Storage temperature:       -4 °F to +140 °F  (-20°C to 

+60°C) 
• Relative humidity:  5-85%, non-condensing 
 

Available 
accessories: 

• Desktop cradle 
• External battery charger 
• Power supply 
• Battery  
• Shoulder strap 
• Case 
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1.8 Bring-in Service (Repairing the Device) 

  
All equipment must be shipped either in the original packaging or in a 
suitably robust packaging! Padded mailing packages or bubble bags will not 
protect the skeye.pad POS adequately against impact and pressure. 
 
 
If you require maintenance or repair services, please contact:  
 
Skeye USA 
12905 S.W. 129th Avenue 
Miami, FL 33186 
Phone: +1 305 909-0173 
Fax: +1 305 596-7222  
info@skeye-usa.com 
www.skeye-usa.com 
 
 
If repair work is required, the device should always be sent along with all 
accessories in the original packaging to skeye USA. The accessories returned can 
help to isolate an error. It is also possible that the defective peripheral devices are 
the cause of the malfunction. 
 
It is imperative that you enclose a written description of the fault or the completed 
service card, if available. This will simplify the troubleshooting process for the 
service technicians significantly and will enable them to return your skeye.pad POS 
sooner. 
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2. Technical Description 

2.1 Views of the skeye.pad POS 

2.1.1 Top View of the skeye.pad POS 
 
 
 
 
 

 
 
 
 
 
Fig. 1: Top view of the skeye.pad POS 
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2.1.2 Top Side View of the skeye.pad POS 
 
 
 
 
 
 

 
 
 
 
 
Fig. 2: Top side view of the skeye.pad POS 

 

2.1.3 Bottom Side View of the skeye.pad POS 
 

 
 
 
 
Fig. 3: Bottom side view of the skeye.pad POS 
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2.1.4 Rear View of the skeye.pad POS 
 
 
 
 
 
 
 
 

 
 
Fig. 4: Rear view of the skeye.pad POS 

 

2.1.5 Ride Side View of the skeye.pad POS 
 

 
 
 
 
Fig. 5: Right side view of the skeye.pad POS 
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3. User Instructions 

3.1 Switching On the skeye.pad POS  

 
Note that you can only switch on the skeye.pad POS after you have inserted a 
charged battery and locked it in place! 
 
 
 
 
 

       
 
 
 
Fig. 6: Rear view of skeye.pad POS with battery removed 

 

1. Slide the battery lock to the left to the symbol  . 
 

2. Place a charged battery with the rounded side facing downwards in the area 
marked (see Fig. 6) at an angle of approx. 45° or less. 
 

3. Fold the battery downwards. 
 

4. Press down slightly on the battery,  
The battery is correctly fitted in the battery recess 
(see the figure below). 
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Fig. 7: Rear view of the skeye.pad POS; correctly fitted battery 

5. Slide the battery lock to the right to the symbol  . 
The battery is now locked and you can switch on the skeye.pad POS. 
 

 

 
Fig. 8: Top view of the skeye.pad POS 

 
6. Press the yellow button on the skeye.pad POS. 

The display lights up and the application is started. 
 
If you cannot start the skeye.pad POS, carry out a reset. 

 
 
If the skeye.pad POS automatically switches to "Suspend Mode" due to an empty 
battery, it cannot be switched on again.  
 
However, the user still has time to replace the battery without losing any data. The 
user receives several warnings in good time before this occurs.  
 
If the battery is not replaced, the skeye.pad POS switches to the "Partially Off" 
status before the battery is fully discharged. If the device is left in the "Partially Off" 
status for more than 20 days, it switches to the "Complete Off" status to conserve 
the floating battery. 
 
The skeye.pad POS cannot be switched on using the yellow button when it is in the 
"Complete Off" status. To do this, you must reset the skeye.pad POS. 

Battery 
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3.2 Switching Off the skeye.pad POS  

3.2.1 Manually Switching Off 
 

 
Fig. 9: Top view of the skeye.pad POS 

 
1. Press the yellow button on the skeye.pad POS. 

The display goes out and the skeye.pad POS switches to "Suspend Mode". 
 

3.2.2 Automatic Switching Off 
If left unused for longer than 2 minutes, the skeye.pad POS automatically switches 
to "Suspend Mode". 
You can increase this time (see Ch. 6.1.6) but this will affect the battery endurance. 
Battery endurance is the time between 2 battery charges. 
 
To maximize the endurance of the battery, the display can automatically switch off 
through several levels. For this purpose, the skeye.pad POS switches to the 
following states when left unused: 
 
Level 1: The display is dimmed (Dim display) default: 15 s 
Level 2: The display is switched off (Turn off display) default: 1 min 
Level 3: The device switches to suspend mode default: 2 min 
  (Auto suspend) 
 
 
The skeye.pad POS does not switch to suspend mode if it is executing program 
processes, for example, when transmitting data or updating master data. 
 
In addition to the suspend mode, the skeye.pad POS can be switched off to 2 
further statuses using the "PowerOff" software function. 
 

 Partially Off  
 Complete Off  

 
 

Yellow On/Off 
Button 
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The differences between the statuses are as follows: 
 
Suspend:  
The skeye.pad POS is switched off. The power supply ensures that the contents of 
the RAM are retained. Windows and all settings are retained in the memory. 
Services such as wireless connections must be restarted. 
 
Partially Off: 
The skeye.pad POS is switched off. The contents of the RAM are deleted. All 
settings are deleted. When the device is switched on again, Windows is reloaded in 
the memory and restarted.  
 
Complete Off (for storing): 
The skeye.pad POS is completely switched off and cannot be switched on using the 
on/off button. The clock stops. The skeye.pad POS must be reset before it can be 
started again. This status is provided for use when the  
skeye.pad POS is stored. 
 
 
1.  To save your data and settings before switching the device to the 

Partially Off or Complete Off status, execute a SysBackup. (see Ch. 8.2.1). 
 

2. Choose Start ⇒ Programs ⇒ System ⇒ PowerOff. 
 

      
 
3. Select the desired switch-off status. 

 
4. Confirm your selection with the "PowerOff" button. 

The skeye.pad POS switches to the selected status. 
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3.3 Removing the Stylus 

  
Only use the stylus supplied to operate the touch screen, as the touch screen 
may be damaged if you use a different stylus! 
 

 
Fig. 10: Right side view of the skeye.pad POS 

 
1. Use your thumb to push the stylus out of the casing. 
 

 
Fig. 11: Detailed side view; removing the stylus 

 

3.4 Operating the skeye.pad POS with the Stylus 

You can use the stylus to navigate, move or select object in the same way as you 
use a mouse on a PC. 
You can also use your fingers to tap the touch screen but the stylus enables you to 
work more precisely. 
 
Instead of clicking with a mouse, simply tap the stylus on the touch screen to select a 
symbol or activate a button. 
 
Double-tapping is the same as double-clicking with a mouse. 

Stylus 
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3.5 Reading a Magnetic Card 

The magnetic card reader can only process magnetic cards that are in perfect 
condition, i.e. the magnetic strip on the card must not be: 

• damaged or  
• warped or  
• cracked 

.  
 
1. Pull the magnetic card smoothly and at right angles to the  

skeye.pad POS from the top to the bottom of the swipe slot. 
 

 
 
 
 
  

X

X

 

Fig. 12: Reading a magnetic card Fig. 13: Bottom side view magnetic 
card at right angle to skeye.pad 
POS in the swipe slot 

 
Note the following points: 
 

 You must turn the magnetic card so that the magnetic strip on the card points 
down on the left. 
 

 You must pull the magnetic card smoothly without interruption along the 
entire length of the swipe slot. 
 

 You must swipe the magnetic card left-aligned to the guide of the swipe slot. 
 

 
 

. 
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3.6 Inserting a Chip Card 

 

 
 
Fig. 14: Right side view of the skeye.pad POS;position of the swipe slot for chip cards 

 
1. Push the chip card all the way to the stop (approx. 1.2 inches or approx. 3 cm) 

with the chip facing down in the reader slot. 
 

Chip Card Reader 
Slot 

Chip Card 

Chip 
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3.7 Tearing Paper along the Paper Cutter 

In order to reduce the weight of the skeye.pad POS, the printer was not fitted with 
an automatic cutting device.  
 
The paper is extremely robust, which is why it may rip if it is not torn off at the 
correct angle. 
 

 
Fig. 15: Tearing paper along the paper cutter; step 1 

 
1. Grip the entire width of the upper edge of the paper. 

 
2. You must tear off the paper evenly to the right at an angle of approx. 45°.  

In this case, you can tear the paper from the bottom up or vice versa. 
 

 
Fig. 16: Tearing paper along the paper cutter; step 2 

 
3. When tearing off the paper, make sure that you pull the paper evenly 

maintaining an angle of 45°. 
 
 

Recommendation: If you are able to move the skeye.pad POS freely, turn the 
skeye.pad POS so that the paper cutter lies horizontally to you and tear the paper 
downwards. 
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4. Maintenance and Support 

4.1 Attaching the Shoulder Strap on the skeye.pad POS 

Both sides of the skeye.pad POS are fitted with a shoulder strap attachment slot. 
 
 

 
 
Fig. 17: Bottom side view of the skeye.pad POS 

 
1. Insert the catch on the holder on the shoulder strap into the larger hole in the 

attachment slot (see arrow 1). 
 

2. To enable the nose on the holder to slide into the smaller hole,  
turn the holder in the attachment slot so that it is at a right angle to the 
attachment slot (see arrow 2). 
 

 
 

 
 
Fig. 18: Sliding the shoulder strap into the attachment slot 

 
3. Slide the holder in the attachment slot to the right (see arrow 3) until it clicks. 

The holder is now locked. 
 

4. Repeat the same sequence of steps on the other side. 
 

Shoulder Strap 
Attachment Slot 

Catch 

Shoulder 

Holder 

Attachment Slot on the  
skeye.pad POS 

1. 

2. 

3. 
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4.2 Removing the Shoulder Strap on the skeye.pad POS 

1. Turn the holder on the shoulder strap so that it is at a right angle to the 
attachment slot. 
 

2. Slide the holder to the left in the attachment slot and lift it out of the attachment 
slot. 
 

3. Repeat the same sequence of steps on the other side. 
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4.3 Resetting the skeye.pad POS 

  
When performing a reset on the device, bear in mind that data can also be lost 
along with the configuration settings! 
 
Data acquired and files created are generally retained. 
However, you should check these to ensure that they are still intact. 
 
The purpose of the reset function is to cancel the running/hanging user program at 
any point. To do this, press the reset button.  
 
 

 
Fig. 19: Detail rear view of the skeye.pad POS 

 
1. To activate the reset button, you need a long thin object such as a straightened 

paper clip.  
 

2. Insert approx. 2/5 inch of a straightened paper clip or similar object (perfectly 
straight) vertically into the access on the skeye.pad POS.  
The reset button is located on a printed circuit board. Inserting an object at an 
angle could damage other sensitive components on the circuit board. 

 
3. Press the reset button carefully with very little effort. 

A reset is performed and the skeye.pad POS switches on automatically. 
 
 

Another reset button is located under the battery (see next page). 

Accessing 
the Reset 
Button 
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Reset button under the battery: 
 
 
 

 
Fig. 20: Detail rear view of the skeye.pad POS with battery removed; location of the second 
reset button 

 
1.  Remove the battery. (see Ch. 4.6, Page 35). 

 
2.  Activate the reset button carefully with very little effort. You can use a 

straightened paper clip or a similar object to do this. 
 

3.  Insert the battery (see Ch. 4.7, Page 37). 

4.  Slide the battery lock to the right to the symbol  . 
The battery is now locked and the skeye.pad POS  
switches on automatically. 

 

Battery Eject 
Button 

Reset 
Button Battery Lock 
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4.4 Resolving Printer Faults 

Fault Solution 
The receipt is not properly pushed out. Check that the paper roll is inserted 

straight. If necessary, remove the paper 
roll and refit it. 

The skeye.pad POS stops midway during 
printing and no longer responds. 

The battery is almost empty and the 
skeye.pad POS has interrupted printing. 
Place the  
skeye.pad POS on the desktop cradle to 
charge it or replace the empty battery 
with a charged one. 

No out-of-paper message is issued at the 
end of a paper role; it is still possible to 
initiate printing. 

Clean the "Out-of-Paper" sensor and the 
paper compartment with a clean, dry and 
lint-free cloth 
(see Ch. 4.8.4, Page 41). 

 

4.5 Replacing the Paper Roll for the Printer 

  
When replacing the paper roll, avoid touching the paper cutter on the 
skeye.pad POS. The paper cutter is fitted with sharp teeth that could easily 
cut your fingers. 
 
 
 
 

 
Fig. 21: Top side view of the skeye.pad POS 

 
1. Pull the printer cover release lever upwards  

The printer cover springs upwards slightly. 
 

Printer Cover 
Release Lever 



MAINTENANCE AND SUPPORT 
 

 
 

34 1.10 • 18.02.2011 

2. Hold the printer cover at the outer sides and fold it upwards.  
 

 
Fig. 22: Inserting the paper roll 

 
3. Carefully remove the empty paper roll from the paper compartment. 

 
4. Insert the new paper roll as shown in Fig. 22. 

 
5. Pull the paper a little way over the paper cutter. 

 
6. Close the printer cover. 

 
7. Press down the printer cover until it locks into place. 

 
8. Tear off the protruding paper cleanly on the paper cutter. 

 

Paper 

Printer Cover 

Paper Cutter 
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4.6 Removing the Battery from the skeye.pad POS  

It is necessary to remove the battery from the skeye.pad POS in order to: 
• replace the battery, 
• access the second reset button, 
• insert or remove the CF card.  
 
1. Press the yellow button to switch off the skeye.pad POS. 

The display goes out and the skeye.pad POS switches to "Suspend Mode". 
 

 
 
 
 

 
 
Fig. 23: Rear view of the skeye.pad POS 

 
2. Slide the  

"Battery Lock" on the rear to the left to the symbol              . 
The battery lock is unlocked and can be removed. 
 

If you insert and lock a charged battery within 3 minutes of unlocking the battery, 
the application you were using when you switched off the device is automatically 
reopened when you switch the device back on. 
 
3. Use the stylus to press the "Battery Eject Button" (see Fig. 23). 

The battery springs upwards slightly. 
 

Battery 

Battery Lock Battery Eject 
Button 
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4. Hold the middle of the battery with one hand. 
The battery has a small indentation at this point that allows you to get a better 
grip of the battery using your finger nail. 

 
5. Continue folding the battery upwards and remove it. 

The battery is now removed. 
 
 
To conserve the floating battery when not in use, the skeye.pad POS should always 
be stored with a charged battery fitted! 
Otherwise the power reserves in the floating battery will be consumed.  
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4.7 Inserting the Battery into the skeye.pad POS  

 
 

 
Fig. 24: Rear view of skeye.pad POS with battery removed 

1. Slide the battery lock to the left to the symbol  . 
 

2. Place a charged battery with the rounded side facing downwards in the area 
marked (see Fig. 24) at an angle of approx. 45° or less. 
 

3. Fold the battery downwards. 
 

4. Press the battery down so that it sits neatly in the battery recess. 
The battery is correctly positioned in the battery recess 
(see the figure below). 
 

 
 

 
 
 
Fig. 25: Rear view of the skeye.pad POS; correctly fitted battery 

Battery 
Recess 

Surface for 
Positioning the 
Battery 

Battery 

Battery Lock 

Battery Lock 
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5. Slide the battery lock to the right to the symbol  . 
The battery is now locked and you can switch on the skeye.pad POS. 
 

  
Instructions for Replacing the Battery: 
 
If you lock a charged battery within three minutes, you can continue working from 
the same point after you switch on the skeye.pad POS again, as is usual after the 
"Suspend Mode".  
 
If the battery is not locked within three minutes, the skeye.pad POS switches to the 
"Partially Off" status. The contents of the RAM are deleted. 
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4.8 Cleaning 

4.8.1 Cleaning the Casing 
Do not use solvents to clean the casing. Use only a soft, dry cloth. 
 
 

4.8.2 Cleaning the Display 
 

  
Only use screen cleaner to clean the display! Otherwise, you will destroy the 
touch screen surface! 
 
 
1. Press the yellow button to switch off the skeye.pad POS. 

The display goes out and the skeye.pad POS switches to "Suspend Mode". 
 

2. Clean the display with screen cleaner and a soft, clean, lint-free cloth. 
 
 

To preserve the surface of the screen, clean the display using a vertical wiping 
motion! 
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4.8.3 Cleaning the Contacts of the Card Reader 
The chip card contacts and the contacts on the magnetic strip reader must be 
regularly cleaned. Use uncoded moist microfiber cleaning cards for this purpose 
(Höft & Wessel order number: E29749).  
 
 
Only use freshly unpacked cleaning cards as the cleaning fluid on the card 
evaporates very quickly. 
 
 
1. Slide the cleaning card into the reader slot of the chip card reader. 

 
2. Slide the cleaning card back and forth several times in the slot. 

 
3. Pull the cleaning card out from reader slot of the chip card reader. 

 
4.  To prevent any of the dirt dislodged from being smeared onto 

the contacts again, pay attention to dirt buildup on the cleaning card. 
 
If the area of the cleaning card you are using becomes dirty, use a different 
clean edge or use a new cleaning card.  

 
5. Slide the cleaning card at least 5x through the reader slot of the card chip 

reader.  
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4.8.4 Cleaning the Paper Recess, Sensor and Light Barrier 

  
When cleaning, avoid touching the paper cutter on the skeye.pad POS. The 
paper cutter is fitted with numerous sharp teeth that could easily cut your 
fingers. 
 
Use only compressed air for cleaning! Do not blow with your mouth as this 
could blow paper dust into your eyes. 
 
1. Open the printer cover; to do this, turn the printer cover release lever upwards. 

 
2. Remove the paper roll from the paper recess. 
 
 

 
Fig. 26: The opened printer cover 

 
3. Use compressed air to clean inside the paper recess. 

 
4.  Use compressed air to clean the out-of-paper sensor. 

Only blow on the out-of-paper sensor! Cleaning it using a cloth or your finger will 
push in the out-of-paper sensor and lead to malfunctions! 

 
5. Carefully clean the light barrier windows using a soft, dry, clean and lint-free 

cloth. 
 

6. Wipe down the paper recess using a clean dry cloth. 
 

7. Insert the paper roll into the paper recess (see Ch. 4.4). 
 

8. Close the printer cover until it locks into place. 

Light Barrier Windows 

Out-of-Paper 
Sensor

Paper 
Compartment

Paper Cutter 
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4.9 Changing the CF Card 

A CF card slot is located under the removable security module . 
 
1. Press the yellow button to switch off the skeye.pad POS. 

The display goes out and the skeye.pad POS switches to "Suspend Mode". 
 

2. Remove the battery (see Ch. 4.6, Page 35). 
 
 

 

 
Fig. 27: Rear view of skeye.pad POS with battery removed; location of the slot for a CF 
card 

 
3. Press the eject button to the right of the slot. 

The CF card is ejected and can be removed. 
 

 
Fig. 28: Slot for the CF card 

Slot 

Eject Button 

Battery Lock 
Eject Button 
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4. Remove the ejected CF card. 

 
5. Push a new CF card with the sleeve terminal facing forwards into the slot until it 

locks. 
The CF card is now correctly fitted. 
 

6. Insert the battery (see Ch. 4.7, Page 37). 

7. Slide the battery lock to the right to the symbol  . 
The battery is now locked and you can switch on the skeye.pad POS. 
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4.10 Replacing the Cover 

The cover is pushed in flush with the underside of the 
skeye.pad POS. The cover has a recessed grip that allows you to push it in and pull 
it out. If your device is equipped with wireless functions, this cover contains 
components.  
 
 
 
 

 
Fig. 29: Pushing in the cover 

 
Carry out the following steps to replace the cover: 
 
1. Press the yellow button to switch off the skeye.pad POS. 

The display goes out and the skeye.pad POS switches to "Suspend Mode". 
 

2. Remove the battery (see Ch. 4.6, Page 35). 
 

3. Press the "Battery Eject Button" and pull out the cover from the skeye.pad POS 
by applying light pressure to the recessed grip.  
 

4. Press the cover into the skeye.pad POS until it is completely fitted and 
encounters a natural resistance. 
 

5. Insert the battery (see Ch. 4.7, Page 37). 

6. Slide the battery lock to the right to the symbol  . 
The battery is now locked and you can switch on the skeye.pad POS. 
 

7. Press the yellow button to switch on the skeye.pad POS. 
The display lights up and the application starts. 

Battery Eject 
Button 

Battery Lock 
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5. Battery Charger (Optional) 

5.1 Charging the Battery in the Battery Charger 

The battery charger allows you to charge the lithium-ion battery separately. The 
recess is molded in such a way that the battery can only be inserted correctly 
(reverse polarity protection).  
 

 
Fig. 30: Battery charger 

 
The battery is inserted into the battery charger for charging. 
Insert the battery in the battery charger in exactly the same way as in the skeye.pad 
POS. Position the battery vertically in the area marked, with the rounded side facing 
downwards. Fold the battery down and press it into place. 
 
Charging the 
Battery 

• To charge a battery, insert into the powered battery charger. 
• If the yellow LED lights up, the battery is correctly inserted in 

the battery charger and is charged. 
 

End of the 
Charging 
Procedure 

• The green LED lights up to indicate that the battery is fully 
charged again. 

 
Charging 
Time 

• A completely discharged battery will take  
approximately 2.5 to 3 hours to recharge. If the battery is not fully 
discharged, the charging time is reduced accordingly. 

 
 
Fold the battery upwards and lift it out of the battery charger. 

Inserting 
the 
Battery 

Removing 
the 
Battery 
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5.2 LED Function Display of the Battery Charger 

Three light emitting diodes (LED) are provided to display the operating states. 
 

 
 
 
Fig. 31: Location of the LEDs 

 
Red LED 
     
Continuously lit 
 
     flashing 

 
 
• Indicates that the battery charger is ready for operation 

 
• Indicates a malfunction 

 
Yellow LED • Indicates: the battery is charging 

 
Green LED • Indicates that charging was successfully completed 

 
 
 
 

Re
Gre

Yell
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6. Handling the Batteries (Power Management) 

6.1.1 Charging the Battery 
If the battery needs to be charged, the following symbol        appears in the menu 
bar. You must then charge the battery! 
 
The battery is automatically charged if your skeye.pad POS 
• is fitted on the desktop cradle (with the power supply connected) 
• is connected to the power supply 
  
 
You also have the option of charging the battery in the battery charger (see Ch. 5). 
 

6.1.2 Battery Maintenance 

  
An unused battery must be recharged every three months. After this length of 
time, the battery is discharged to such an extent due to self-discharging that 
it can no longer be used to operate a skeye.pad POS. 
 
 
In terms of maintenance, bear the following points in mind: 
 

 Good: 
• Daily use of the battery 
• Allowing the battery to discharge until the "Charge Battery" symbol appears in 

the menu bar (see Ch. 6). 
• Charging using the battery charger HW 16396 or the desktop cradle HW 50396 
 

 Bad: 
• Only occasionally using the battery 
• Exposure to heat (increases self-discharging) 
• Exposure to frost  
 

 Very Bad: 
• Total discharging 
• Humidity; aggressive vapors that cause corrosion of the contacts 
• Storage at temperatures below -4.0 °F (-20°C) 
• Storage at temperatures below +32.0 °F (0°C) 
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6.1.3 Maintaining the Internal Floating Battery 

  
To conserve the floating battery when not in use, the skeye.pad POS should 
always be stored with a charged battery fitted! 
Otherwise the power reserves in the floating battery will be consumed. 
Discharged floating batteries must be replaced by qualified service personnel. 
 
If the battery is unlocked, the internal floating battery supplies the RAM with voltage 
for 3 minutes. This ensures that the RAM is not deleted during this time and that it is 
possible to change the battery while the RAM is in use. After you switch on the  
skeye.pad POS, you can continue working from the same point. 
 
The internal floating battery requires no maintenance. The skeye.pad POS 
automatically charges the internal floating battery. If the  
skeye.pad POS is not placed on a desktop cradle for an extended period, the 
internal floating battery is charged from the battery. 
 

6.1.4 Disposing of Old Batteries 
Under no circumstances should you dispose of spent batteries in the normal 
household trash as the heavy metals they contain pose a serious environmental 
hazard. 
 
All spent batteries must be sent to a special disposal facility. For this reason, they 
must be returned to Höft & Wessel.  
For the relevant address, see Ch. 1.8 Page 17.  
As part of its normal service activities, Höft & Wessel ensures that all spent 
batteries are properly processed and disposed of. 
 
This system of returning the batteries ensures that the chemicals they contain are 
100% recyclable. This circular flow of recyclable resources eliminates any burden 
on the environment. 
Höft & Wessel guarantees that all returned batteries are fed into this circular flow. 
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6.1.5 Storing the skeye.pad POS with the Battery 

  
To conserve the floating battery when not in use, the skeye.pad POS should 
always be stored with a charged battery fitted! 
Otherwise the power reserves in the floating battery will be consumed. 
Discharged floating batteries must be replaced by qualified service personnel. 
 
If the battery is removed or empty, the contents of the SRAM disk are powered by 
the floating battery. This significantly reduces the service life of the floating battery. 
An empty floating battery can cause the skeye.pad POS to malfunction. Discharged 
floating batteries must be replaced by qualified service personnel. 
 
The skeye.pad POS can be stored in "Complete Off" mode with a charged battery 
for up to six months without maintenance.  
 
The device can be stored with a charged battery in "Suspend" mode for up to three 
weeks without maintenance. Depending on the battery status, the skeye.pad POS 
then automatically switches to "Partially Off" or "Complete Off" mode. 
 
If these storage periods are exceeded, power is drawn from the floating battery. A 
charged battery must be used afterwards. 
Storage should always be at room temperature (approx. 68 °F or 20°C). 
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6.1.6 Influencing the Battery Endurance 
To maximize the endurance of the battery, the display can automatically switch off 
through several levels. For this purpose, the skeye.pad POS switches to the 
following states when left unused: 
 
Level 1: The display is dimmed (Dim display) default: 15 s 
Level 2: The display is switched off (Turn off display) default: 1 min 
Level 3: The device switches to "Suspend Mode" default: 2 min 
  (Auto suspend) 
 
 
The times at which the skeye.pad POS switches from one status to the other can be 
changed using the "AutoOff" function in the Control Panel.  
 
1. Choose Start ⇒ Settings ⇒ Control Panel ⇒  

 

 
Fig. 32: The "Auto Off" window 

 
2. Use the checkboxes and the controllers to adjust the settings as required and 

confirm the settings with [OK]. 
 

Note the following: The shorter you set the times, the longer the battery is 
available until the next charge. 
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7. Additional Functions and Settings 

7.1 Calling the Desktop at any Time 

To minimize or hide all open windows, tap the following symbol in the menu bar on 
the bottom right  
   

7.2 Displaying and Hiding the Keyboard 

Displaying:    Tap the symbol  in the  
menu bar and select the required keyboard. 

Hiding: Tap the symbol  in the menu bar and select "Hide Input Panel". 
 
 
 

7.3 Hiding the Numerical Keyboard 

If you select "skeye Keyboard" or "Large Keyboard", you can limit the keyboard to 
numerical keys (numeric pad) only. 
 

 
 
 

 
Fig. 33: skeye keyboard; function of the x-key 

By tapping on the x-
key, you can switch 
between the 
alphanumeric 
keyboard and the 
numeric pad. 

Numeric pad 

Alphanumeric 
Keyboard  
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7.4 Setting the Properties of the Input Panel (Keyboard) 

1. Choose Start ⇒ Settings ⇒ Control Panel. 
The "Control Panel" window opens. 
 

2. In the "Control Panel" window, select the "Input Panel" symbol  
by double-tapping. 
The "Input Panel Properties" window opens.  
 

 
Fig. 34: The "Input Panel Properties" window 

  
3. In the "Input Panel Properties" window, select the relevant Current input 

method (skeye keyboard, Large Keyboard, LargeKB) and then select the 
[Options…] control button. 
Depending on the selected input method, another "Skeye Keyboard Options" 
window opens.  
 

 
Fig. 35: The "Skeye Keyboard Options" window if the Skeye keyboard is selected 

 
4. Create the required settings in the "Skeye Keyboard Options" window. 

 
5. Select [OK] to confirm your entries. 
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7.5 Calibrating the Touch Screen 

This function is required for fine adjustment of the touch screen, i.e. the more 
precisely the touch screen is calibrated, the more precisely it reacts. 
  
Note the following when calibrating the touch screen:  

Touch the screen lightly but firmly! 
Do not pull the stylus across the touch screen! 
Do not rest your hand on the touch screen! 

 
Use the touch program on the desktop to calibrate the touch screen. The settings 
created in this program are stored in the flash memory and are therefore also 
available after a reset. Alternatively, you can also use the "TestSuite" program. 
 
The Windows settings under Start/Settings/Control Panel/Stylus are not stored in 
the flash memory and are deleted during a reset. 
 
1. Select the "Touch" symbol on the desktop by double-tapping 

or  
Start ⇒⇒⇒⇒ Programs ⇒⇒⇒⇒ System ⇒⇒⇒⇒ Touch Calibration 
The calibration window opens 
 

 
Fig. 36: The calibration window 

 
2. Position the stylus in the center of the superimposed cross and hold this point 

until the cross moves on. 
 
Remark: The more precisely you place the stylus in the center, the more 
precisely the touch screen reacts afterwards.  
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3. Follow the same procedure for the crosses subsequently displayed. 
After the last cross, the "Apply" inquiry window appears with a timer in the 
calibration window.  
 

4. Tap on the [Apply] button to confirm. 
The calibration window is closed and the following inquiry appears: 

 

 
Fig. 37: Inquiry "Touch calibration" 

 
5. Confirm this inquiry with [OK]. 

The calibration settings are written into the flash memory. 
 

 
The touch screen and its calibration may shift over time. If you notice that the touch 
screen no longer reacts as precisely, execute the "Touch Calibration" function 
again. 
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7.6 Setting the Date and Time 

1. Choose Start ⇒ Settings ⇒ Control Panel. 
The "Control Panel" menu opens. 
 

2. In the "Control Panel" menu, select the "Date/Time" symbol  
by double-tapping.  
The "Date/Time Properties" window opens 
 

 
 

Fig. 38: The "Date/Time Properties" window 

 
3. In the "Date/Time Properties" window, set the following: 

• The current date, 
• the corresponding Time Zone and only then 
• the Current Time 
  
 

4. Select [Apply] to confirm your entries. 
 

5. Close the "Date/Time Properties" window with [OK]. 
 



ADDITIONAL FUNCTIONS AND SETTINGS 
 

 
 

56 1.10 • 18.02.2011 

7.7 Entering Owner Properties 

1. Choose Start ⇒ Settings ⇒ Control Panel. 
The "Control Panel" menu opens. 
 

2. In the "Control Panel" menu, select the "Owner" symbol   
by double-tapping.  
The "Owner Properties" window opens. 
 

 
Fig. 39: The "Owner Properties" window 

 
3. In the "Owner Properties" window, complete the fields. 

 
4. Select [OK] to confirm your entries 
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7.8 Adjusting the Brightness 

1. Choose Start ⇒ Settings ⇒ Control Panel. 
The "Control Panel" menu opens. 
 

2. In the "Control Panel" menu, select the "Backlight" symbol  
by double-tapping. 
The "Backlight" window opens. 
 

 
Fig. 40: The "Backlight" window, "Brightness" tab 

 
3. Use the arrow button in this window to adjust the  

brightness. 
 
To conserve battery power, minimize the brightness. 
 

4. Select [OK] to confirm your entries. 
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7.9 Setting the Volume & Sounds 

  
Deactivating sounds will save energy and extend the lifetime of the batteries. 
 
1. Choose Start ⇒ Settings ⇒ Control Panel. 

The "Control Panel" menu opens. 
 

2. In the "Control Panel" window, select the "Volume & Sounds" symbol by 
double-tapping. 
The "Volume & Sounds Properties" window opens. 
 

 
Fig. 41: The "Volume & Sounds Properties" window, "Volume" tab 

 
3. In the "Volume & Sounds Properties" window, create the relevant settings. 

 
4. Select [OK] to confirm your entries. 
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7.10 Creating an Additional Symbol on the Desktop 

If particular functions are frequently required, it is useful to store them on the 
desktop. If a frequently required function is missing from the desktop, proceed as 
follows:  
 
1. Double-tap the "My Computer" symbol. 

The "My Computer" directory opens. 
 

2. In the workplace directory, select the "Windows" folder by double-tapping. 
The "Windows" folder opens. 
 

3. In the "Windows" folder, search for the EXE File for the function that you want to 
created on the desktop and select it. For example, for the "Operating Mode" 
function, this is "commodus.exe". 
 
You can find the name of the EXE in the relevant chapter for the function. The 
file always has the name like the command that must be entered in the 
"Execute" window for the function. 
 

 
Fig. 42: The "Windows" folder with the submenu open 

 
4. Open the "File" menu and select the "Send To" submenu. 

The "Send to" submenu opens. 
 

5. In the "Send To" submenu, select the "Desktop as Shortcut" function. 
The link is created. 
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7.11 Installing Software 

You can load and install software 
• from the Internet onto your skeye.pad POS or  
• via a connection with your desktop PC (using the desktop cradle) 
   
 
Note the following when installing: 
 
When choosing software, always check that it is compatible with  
XScale processors and Windows CE or Handheld PC 2000.   
 

If you intend installing the software permanently on your skeye.pad POS, you must 
save it in the "FlashDisk" folder. 
Otherwise, the data will be deleted, for example, when the device is switched to 
"Complete Off". 
 
Certain programs install additional components in the \Windows directory 
irrespective of the target path chosen. 
We recommend that you manually save these components in the 
"FlashDisk" folder to ensure that they are still available after a "Complete Off". 
 
To restore the software, you must copy these files manually into the \Windows 
directory again. 
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8. Data Backup 

 
To save your data and settings before the device is switched off to the 
Partially Off or Complete Off status, carry out a SysBackup (see Ch. 8.2.1)! 
 

8.1 Data Backups in General 

The memory of the skeye.pad POS consists of two areas: 

• up to 1 GB flash and 
• up to 256 MB RAM. 
 
In the RAM, Windows CE creates 

• the RAM,  
• the files,  
• the databases and  
• the registry  
  
The RAM memory allows rapid access. 
It is battery buffered, which means that the contents of the RAM memory are 
deleted if the battery is deeply discharged. 
 
The flash memory stores all the data contained in the "FlashStorage" folder and its 
subdirectories.  
The flash memory retains its data even if the battery is discharged. 
 
For this reason, all important files and programs should be saved in the 
"FlashStorage" folder. 
You should therefore back up the data on your skeye.pad POS as often as possible! 
 
We also recommend that you copy important data onto your desktop PC or other 
storage media such as CDs. 
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8.2 SysBackup 

You can use the "SysBackup" program to 
• create, 
• play back and 
• delete a backup. 
 

8.2.1 Creating a Backup 
You should copy all important data to the "\FlashDisk" folder or its subdirectories. 
 
To ensure that all system settings are not lost after the battery is discharged or the 
device is switched to "Complete Off", you must save everything. 
 
1. Start the "SysBackup" program, either: 

choose Start ⇒⇒⇒⇒ Run and enter "SysBackup" in the input line in the "Run" 
window or 
choose Start ⇒ Programs ⇒ System ⇒ SysBackup. 
The "SysBackup" window opens.  
 

 
Fig. 43: The "SysBackup" window 

 
2. In the "SysBackup" window, select the [create] button by tapping. 

The "Execute backup?" message appears. 
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Fig. 44: The "SysBackup" window with the "Execute backup?" message 

 
3. Confirm the "Execute backup?" message with [Yes]. 

The SysBackup is executed. On completion, the following message appears. 
 

 
Fig. 45: The "SysBackup" window with the "Backup completed" message 

 
4. Close the message with [OK]. 

 
5. Close the "SysBackup" window by tapping on the [Exit] button. 
 
 
If you change your system settings (e.g. recalibrating the touch screen),  
you must then perform a SysBackup. Otherwise these settings will be lost, for 
example, if the device is switched to "Complete Off". 
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8.2.2 Restoring a Backup 
1. Open the "SysBackup" program. 

 

 
Fig. 46: The "SysBackup" program  

 
2. In the "SysBackup" window, select the [restore] button by tapping. 

The "Execute restore?" message appears. 
 

 
Fig. 47: The "SysBackup" program with the "Execute restore?" message 

 
3. Confirm the "Execute restore?" message with [Yes]. 

The backup is imported. 
 

4. Close the "SysBackup" window by tapping on the [Exit] button. 
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8.2.3 Deleting a Backup 
1. Open the "SysBackup" program. 

 

 
Fig. 48: The "SysBackup" program  

 
2. In the "SysBackup" window, select the [delete] button by tapping. 

The "Erase backup files?" message appears. 
 

 
Fig. 49: The "SysBackup" program with the "Erase backup files?" message 

 
3. Confirm the "Erase backup files?" message with [Yes]. 

The contents of the directory \FlashDisk\SYSBAK are deleted. 
 
4. Close the "SysBackup" window by tapping on the [Exit] button. 
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9. Communication/Data Exchange 

9.1 General Information on Exchanging Data with your Desktop PC 

You can connect your skeye.pad POS through a desktop cradle via USB cable to 
your desktop PC.  
  
Before you establish the connection, you must install ActiveSync on your desktop 
PC. You can then connect your skeye.pad POS and set up a partnership with your 
desktop PC. 
It is possible to use your skeye.pad POS to set up several partnerships with 
different desktop PCs. To do this, you need an additional desktop cradle (e.g. 
office/home). 
 

9.2 Installing ActiveSync on your Desktop PC 

You can use the ActiveSync program to carry out the following tasks (between your 
desktop PC and your skeye.pad POS): 
• Saving and restoring your skeye.pad POS data 
• Adding and removing programs to and from your skeye.pad POS  
• Synchronizing files  
• Transferring and copying files 
  
 
For more information, for example, about the system requirements, refer to the 
Microsoft website. 
 
1. Start Internet Explorer or another browser on the desktop PC. 

 
2. Enter the Internet address www.microsoft.com in Internet Explorer. 

 

 
Fig. 50: The Microsoft website 
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3. Select "ActiveSync" under "Downloads" on this page and confirm your selection 
with "Go".  
 

4. Follow the instructions displayed to install ActiveSync. 
 

5. Then restart your desktop PC. 
 

6. After you restart the PC, the system displays the "Create connection" dialog 
window, in which you are requested to create a connection with your skeye.pad 
POS. 

 

9.3 Receiving and Sending Data 

9.3.1 skeye.pad POS – Desktop PC 
We recommend the "ActiveSync" program for communicating with your PC 
(Installing the Program, see Ch. 9.2). 
 
1. Insert your skeye.pad POS in the connected desktop cradle. 

 
2. Switch on your skeye.pad POS. 

 
3. Switch on your desktop PC. 

 
The connection is automatically established. The "Connecting to USB" window 
opens. 
 

 
Fig. 51: The "Connecting to USB" window 

 
Once the connection to the desktop PC is established, the window is 
automatically hidden and the "New Partnership" window appears (see next 
page). 
 
If no connection is established, check that the cable is correctly connected and 
that the skeye.pad POS is correctly positioned in the desktop cradle and try 
again. 
If you are still unable to establish a connection, follow the steps described in Ch. 
10.1. 
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Fig. 52: The "New Partnership" window 

 
4. In this window, you have the option of choosing 

• "Yes" to synchronize your skeye.pad POS with your PC, or choosing  
• "No" to log on to the PC as a "Guest". 

 
Select     "Yes"  (see Ch. 9.3.1.2) or 

"No"  (see Ch. 9.3.1.1) and  
 
     then confirm with [Next >] 
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9.3.1.1 "No" – Logging on as a Guest  
If you use your mobile terminal to log onto a desktop PC as a guest, you can copy 
or move files from the desktop PC to the skeye.pad POS and vice versa. 
The calendar and files cannot be automatically synchronized. To do this, you must 
create a partnership. 
 
If you selected "No" in the "New Partnership" window, the following window 
appears: 
 

 
Fig. 53: The "Microsoft ActiveSync" window, logging on as a guest 

 
1. You can now access the skeye.pad POS from your desktop PC.  

To do this, click on the "My Computer" symbol on the desktop  
of your PC. 
The "My Computer" window then opens showing all the available directories and 
devices. 
 

 
 
2. Select the symbol for your skeye.pad POS  

and a directory on the desktop PC that you want  
to work on. 

My Device 
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9.3.1.2 "Yes" - Setting up a Partnership 
If you use your skeye.pad POS to set up a partnership on a desktop PC, you can 
copy or move files from the desktop PC to the skeye.pad POS and vice versa. You 
can also automatically synchronize the calendar and files. 
 
If you selected "Yes" in the "New Partnership" window, the following window 
appears: 
 

 
Fig. 54: The "New Partnership" window (PIM) 

 
1. Select the required programs here and confirm your entries with [Next >]. 

The following window opens.  
 

 
Fig. 55: The "New Partnership" window, synchronization settings 

 
2. In this window, activate the checkboxes for the areas that you wish to 

synchronize with your skeye.pad POS. 
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3. Then select the [Settings…] button to specify the properties of the 
synchronization. 
Depending on the areas selected, a corresponding synchronization window 
opens, e.g.: 
 

 
Fig. 56: The "Calendar Synchronization Settings" window 

 
4. In this window, select the required settings. 

 
5. Select [OK] to confirm your entries 

The "New Partnership" window, "Synchronization Settings" appears. 
 

 
 
6. Select [Next >]. 

The following window opens:     
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Fig. 57: The "New Partnership" window, "Setup Complete" 

 
7. In this window, select [Finish]. 

The setup starts. 
 
After the setup is complete, the following window appears: 

 

 
Fig. 58: The "Microsoft ActiveSync" window, logging on as a partnership 
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9.4 Creating a New Connection 

 

9.4.1 Ethernet Settings 
This setting is not normally required as the internal Ethernet controller automatically 
switches on as soon as an external current supply is connected to the skeye.pad 
POS. 
 
The internal controller can also be switched on or off using the "CFConfig" tool. 
 
1. Double-tap the "CFConfig" symbol on the desktop.  

The "CF-Slot Configuration" window opens. 
 

    
Fig. 59: The "CF-Slot Configuration" window 

 
2. Activate the checkbox "Enable internal Ethernet controller (LAN)" in the  

"CF-Slot Configuration" window. 
 

3. Close the "CF-Slot Configuration" window with [OK]. 
 
4. Select Start ⇒ Settings ⇒ Network and Dial-up Connections.  

The "Network and Dial-up Connections" window appears. 
 

 
Fig. 60: The "Network and Dial-up Connections" window 

5. Double-tap the following symbol to configure the Ethernet connection. 
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10. Appendix 

10.1 Hardware Data 

Casing: • Ergonomically shaped: Equally suitable for left and right-
handed users 

• Plastic stylus for touch control stored in casing. 
(stylus) 

• Fastener for shoulder strap 
 

Dimensions: Casing dimensions in  (WxHxD) in inches and (WxHxD) in mm  
• at the paper roll:    approx. 9.448819" x 5.23622" x 

1.771654"  
                                 approx. 240 mm  x 133 mm x 45 mm  

• Remaining casing: approx. 9.448819" x 5.23622" x 
1.259843 
                                 approx. 240 mm x 133 mm x 32 mm  

 
Weight: Depending on the equipment, approx. 2,2046 pound (1000 g) 

 
Processor: • Intel PXA250 XScale processor 

• clock speed 400 MHz 
 

Operating 
system: 

Microsoft Windows CE 5.0 
 

Memory: • 64 – 256 MB SDRAM depending on equipment variant 
• 128 MB – 1 GByte FLASH depending on equipment variant 
• 1 Mbyte boot flash 
• 512 Kbyte SRAM 
 

Peripheral  
controller: 

The processor controls several peripheral components, for 
which real-time requirements are necessary, such as: printer, 
magnetic card reader, chip card reader, power management 
etc. 
• 24 MHz 
• 512 Kbyte Flash 
• 512 kbyte SRAM 

 
Display: • 6.4" VGA color TFT LCD, 640 x 480 pixels,  

18-bit color depth 
• transmissive 
• integrated touch screen 
 

Keyboard: • 5 control buttons alongside the display 
 

Buttons: • 2 reset buttons 
 

  



APPENDIX 
 

 
 

1.10 • 18.02.2011 75 

Notes about 
thermal paper 

• Keep the paper in a cool and dry location. 
 

For more information about the temperature range and air 
humidity, refer to the paper specification issued by the paper 
manufacturer . 

10.2 Special Commands 

The table below contains special commands not included in the standard Windows 
CE system: 
 
Call from the start menu:  
Start  Run…  
Start   Programs  System  
 
Special 
Command 

Result 
   

Reset Resets the skeye.pad POS.  
All running programs are terminated. 
 

SysBackup Creates a backup of, or restores, all programs and data in the 
RAM in the flash disk. This is useful, for example, in advance of 
switching the device to Complete Off. 
 

SysInfo Displays the operating system version and the device number 
 

PowerOff Complete Off: The battery is switched off, the RAM contents are 
lost. All programs and data should be backed up from the RAM file 
system to the flash disk beforehand with the aid of SysBackup. 
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10.3 The ActiveSync Connection cannot be Established 

10.3.1 Checking Connection Settings on the Desktop PC 
1. Start ActiveSync on the desktop PC. 

 

 
Fig. 61: The "ActiveSync" program window with the "File" menu open 

 
2. In the "File" menu, select the "Connection Settings..." submenu. 

The "Connection Settings" window. 
 

 
Fig. 62: The "Connection Settings" window 

 
3. Check and, if necessary, adjust your entries. 

 
4. Confirm your entries with [OK]. 

You must activate 
this checkbox  
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10.3.2 Checking the Registry Entries 
If it is not possible to establish an ActiveSync connection between skeye.pad POS 
and PC, Microsoft recommends checking and, if necessary, adding the following 
registry entries on the PC: 
 
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows CE Services] 
 
"SerialPort"="COM1"      (or COM2) 
 
 
[HKEY_CURRENT_USER\Software\Microsoft\Windows CE Services] 
 
"SerialBaudRate"=0001c200 (115200)   (for 115 kbit/s) 
 
 
Procedure: 
 
• On the PC: Choose Start ⇒ Run… ⇒ "Regedit" 
• Click on HKEY_LOCAL_MACHINE  
• Open \SOFTWARE\Microsoft\Windows CE Services 
• Are both entries present? 
 
If not, create them again: 
 
• Click on Windows CE Services 
• Choose the menu item   Edit ⇒ New ⇒ Character Sequence 
• Enter ”SerialPort” as a name (without quotation marks) 
• Double-click "SerialPort", the "Edit character sequence" window opens 
• Select "Decimal",  enter 115200 
• Select the menu item   Edit ⇒ New ⇒ DWORD value 
• Enter "SerialBaudrate" as a name (without quotation marks) 
• Double-click on "SerialBaudRate", the ”Edit DWORD value" appears 
• Enter COM1 (or the COM port you are using) 
• Exit the Registry Editor 
• Restart the PC so that changes can take effect. 
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10.4  Manufacturer's Address 

Höft & Wessel AG 
Rotenburger Str. 20 
30659 Hannover 
Germany 
 
Tel: + 49 (0)511/6102 - 0 
Fax: + 49 (0)511/6102 - 411 
 
www.hoeft-wessel.de 
info@hoeft-wessel.de 
 
Service Line: + 49 (0)1803 / 23 28 29  (throughout Germany 0.09 EUR per min) 

 
 
 
Sales: 
Skeye USA 
12905 S.W. 129th Avenue 
Miami, FL 33186 
 
Phone: +1 305 909-0173 
Fax: +1 305 596-7222 
 
info@skeye-usa.com 
www.skeye-usa.com 
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